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B 

Exercise Introduction 

1. Exercise Aim and Plan 

The aim of this exercise is first to get acquainted with yet another work configuration of power 
semiconductor devices, the bridge. Second, electric motor control will be taken advantage of as a 
practical application example. 

Generally speaking, both these issues are fairly complex due to the large number of possible 
control strategies for bridge switches as well as the multitude of motor solutions. For this reason, we 
will restrict to a control method that is simple and yet enables a complete analysis of the circuit. 
Also the motor chosen—a permanent magnet DC one—is among all the electric motors the easiest 
one to control. It will enable gaining the most basic knowledge about the specificity of power 
converter operation with RLE receivers. A DC/DC bridge converter will be the power converter used 
in this exercise. 

Converter characteristics will be determined in this exercise, including those independent and 
those dependent on the receiver, as well as one of the typical characteristics of the electric motor. 
On the other hand, the operation of the DC/DC bridge converter will be investigated at the current 
and voltage level, including drive circuits of the transistor switches. 
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2. Motor Control in the Bridge Configuration 

2.1. Recommended reading 

Ref. Textbook Excerpt 
Equivalent in the 

Polish Manual 
Complementary 

Reading 
Complements 
in this Manual 

A Moh 7-7, 7-7-1, 7-7-2 2.1, 2.2.a, 2.4.a—b, 
2.5 

 2.2.c 

B Moh 13-1, 13-2, 13-3 2.3, 2.4.c—e  2.2.a—b,d—e 
 

2.2. DC motor control using a full-bridge converter 

2.2.a. Classification of electric motors 

Motors are often the controlled systems for power electronic circuits. The complex system of 
their classification is based on two criteria: supply and control. With respect to supply, AC motors 
and DC motors may be discerned in first place. The first group is much more numerous as far as the 
diversity of solutions is concerned. Supply and control of AC motors is also much harder and more 
advanced technical solutions need fairly complex microprocessor systems. 

DC motors are simpler to control. Several cases may be discerned in this respect: 

(1) series-wound motors that have two windings generating the magnetic field, with an 
exciting winding, called the field winding, connected in series with a main winding, 
called the armature; 

(2) shunt-wound motors where field winding and armature are connected in parallel; 

(3) compound-wound motors where the connection is partially in series and partially in 
parallel; 

(4) separately excited motors (or sepex motors) where field winding and armature are not 
connected: 

(a) with traditional (electromagnetic) excitation, where two windings are found as 
previously, 

(b) permanent-magnet DC motors (PMDC) that have only one winding—the 
armature, while the field winding is replaced with permanent magnets. 

In the last design (4b) the excitation is constant and controlling the motor is only possible using 
the armature. Thanks to that, control is simpler although at the expense of some limitations. A 
motor from this group will be used in the present exercise. 



8 ◆ B 2 Power Devices and Systems. Exercise 4B. Insulated Gate Bipolar Transistor (4.3.6) 

© 2016 Łukasz Starzak, Katedra Mikroelektroniki i Technik Informatycznych Politechniki Łódzkiej 

2.2.b. Mechanical quantities describing motors 

Rotational speed n is the number of rotations produced in a given time, expressed in 1/s or, 
customarily, in revolutions per minute (rpm). Rotation can also be described with angular velocity ω 
which is the angle by which on object rotates in a given time, expressed in rad/s (mathematically 
equivalent to 1/s). The values of these two quantities are related to each other as 

 nπ2=ω  (2.1) 

because one revolution means a change of 360° in angular position, which is 2π radians. Angular 
velocity is generally a vector, parallel to the axis of rotation, whereas rotational speed is considered 
a scalar. 

Torque (or moment of force, or moment) is the measure of a force producing a rotational 
movement, defined as the vector product of the position vector r, connecting the point of force 
application to the rotation axis, and this force F: 

 FrT
rrr

×=
Δ

 (2.2) 

Expressed with scalars, this becomes 

 rFFrT ⊥== θsin  (2.3) 

where θ is the angle between the force vector and the position vector and F⊥ is the value of the force 
F component perpendicular to the vector r. The unit of the torque is 1 N×m. 

In a motor, electromagnetic torque Tem is induced by the interaction of magnetic fields inside. As 
a result, mechanical torque Tm is created at the motor’s shaft which can be regarded as the force F 
that the motor would exert on a mass attached to its shaft at a distance of r. This situation is 
however quite abstract; in reality, the motor torque sets a load in motion (not necessarily a rotary 
one) through a mechanical gear. Any difference between the electromagnetic and the mechanical 
torques results from damping mechanisms, first of all friction. The damping torque is proportional to 
velocity ωm with some coefficient of damping (or friction) B. 

In general, the motor is loaded with some working load torque TWL. According to the first 
principle of dynamics, at equilibrium, i.e. when the motor’s velocity ωm remains constant, the 
equivalent working load torque TWL(eq) equals the mechanical torque Tm. The equivalent load TWL(eq) is 
proportional to TWL and accounts for the gear. A special case is when the load torque TWL equals 0; it 
is called the idling state. 

2.2.c. Output voltage characteristic for the full-bridge DC converter 

As demonstrated in Ref. A [see Eq. (7-74)], the average output voltage, or the output voltage DC 
component Vo, is 

 d1io )12()12( VDVDV −=−=  (2.4) 

where Vi = Vd is the input (supply) voltage of the full-bridge and D is the duty cycle of one of the 
bridge transistors, D1. This is the basic control characteristic of the full-bridge converter. In order to 
give it a universal character, it is usually presented in the relative form, related to the input voltage, 

 
i

o
Δ

o(r)
V

V
V =  (2.5) 

which leads to 

 12o(r) −= DV  (2.6) 



Motor Control in the Bridge Configuration B 2 ◆ 9 

© 2016 Łukasz Starzak, Katedra Mikroelektroniki i Technik Informatycznych Politechniki Łódzkiej 

This relationship has been presented in Fig. 1. 

As stated in Ref. A, the voltage control characteristic of an ideal converter is independent of 
current. However, it is dependent in a real circuit because of non-zero switch resistances. These 
cause a decrease in the output voltage by the amount of voltage drops across semiconductor 
switches included in the current conduction loop. As voltage drops are always dependent on current 
to some extent, the output voltage characteristic of a real converter will also exhibit this 
dependence. 
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Fig. 1. Output voltage control characteristic of an ideal full-
bridge DC/DC converter 

2.2.d. Current and power for a full-bridge converter-controlled DC motor 

For a general large inductive load, such as a motor’s armature, the output current waveform io = 
ia can be assumed to be triangular (see Fig. 7-28 in Ref. A). Under this assumption, a formula for the 
average output power can be derived as 

 atoooo
s

o

s0

0

d
1

IVIVtiv
T

P
Tt

t

=== ∫
+

 (2.7) 

where Io = Ia is the DC component of the converter output current, or the motor armature current. 

For an RL load, the Ohm’s law applies to average values, so 

 
o

o
o

R

V
I =  (2.8) 

where Ro is the load resistance. After substituting (2.4) and (2.8) into (2.7), we obtain the following 
control characteristic of the average output power 

 
o

2
i2

o

2
o

o )12(
R

V
D

R

V
P −==  (2.9) 

To an RLE load such as an electric motor, Eq. (13-12) applies, so 
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where Ea is the DC component of the electromotive force ea produced by a rotating DC motor, 
proportional to its angular velocity ωm and to the field winding torque Φf according to Eq. (13‑11). 
Substituting this to (2.7), we get 

 
a

at
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t
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R

EVV
P

−
=  (2.11) 

In order to obtain a characteristic as a function of the duty cycle, we must first relate Ea to Vt 
through the angular velocity ωm. 

2.2.e. Idling state control characteristics 

Equation (13‑13) still does not give a clear picture of motor control characteristics using a full-
bridge converter, because its right-hand side contains the electromagnetic torque which is linked to 
the left-hand side, i.e. to the angular velocity. In steady state (ωm = const, TWL = const), this link is 
described with Eq. (13‑11) whereas from Eq. (13‑9), the torque is expressed with 

 WLmem TBT += ω  (2.12) 

 Substituting these into (13‑13), we have 
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After rearranging, 
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In its final form, the result shows that also after the relation of torque to velocity is taken into 
account, the angular velocity is essentially a linear function of the DC component of the armature 
voltage Vt, or of the average converter output voltage Vo. Following (13‑5), it is also a linear function 
of the control signal duty cycle. The coefficients of this relationship result from the motor properties 
described by kE, kT and B. However, an empirical law of mechanics says that the coefficient of kinetic 
friction B is a decreasing function of the relative velocity of the objects that experience this friction. 
Therefore, in reality, we will observe some divergence from the linear law. 

For the idling state, Eq. (2.14) takes a simpler form of 

 
TE kBRk

V

a

t
m +

=ω  (2.15) 

whereas for an ideal motor (B = 0) this would become 

 
Ek

Vt
m =ω  (2.16) 
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In this case, the relation is not only linear but proportional. Using (2.1), Eq. (2.15) can be re-written 
for the rotational speed: 

 ( )TE kBRk

V
n

a

t
m

π2 +
=  (2.17) 

Substituting (2.15) into (13‑11) yields 
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After substituting into (2.11), this in turn permits obtaining the average power control 
characteristics for the idling state: 
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which can be rearranged into 
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Considering the universal voltage conversion characteristics (2.4), the idling state characteristics 
for a motor controlled with a full-bridge converter are expressed as following as functions of the 
duty cycle: 
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Based on (2.10), (2.21) and (13‑11), the armature current DC component is 
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Equation (2.21) tells that the idle velocity is approximately (with friction neglected) a linear 
function of the duty cycle D. As (2D − 1) ∊ [−1; 1], the result can be either positive or negative. 
Considering that the angular velocity is a vector, this should be interpreted as rotation in different 
directions. 

Looking at Eq. (2.22), it can be concluded that the average output power for an RLE load in the 
form of a DC motor is approximately a quadratic function of the duty cycle D. Its precise form will 
depend on the character of the B = f(ωm) relationship for given motor and external mechanical 
system. 

Substituting B = 0, it is easy to determine that an idling ideal motor draws zero power and zero 
current, whereas these quantities increase with increasing B. Considering (2.13), the effect of adding 
a working load is similar as the corresponding torque TWL adds to the damping torque Bωm (except 
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that the former does not depend on velocity). This is an expected result: the greater the load of the 
motor’s shaft, the greater electric power must be drawn to produce rotation with a given velocity, 
which in turn means a greater current drawn. Taking B → ∞, it can be determined that with 
increasing damping torque (or, similarly, working load torque), the power characteristics tends to a 
limit which appears to be the value obtained for an RL load of an equal resistance (Ro = Ra), 
expressed with Eq. (2.9). 
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C 

Experiment 

3. Measurements 

3.1. Measurement circuit setup 

Circuit description 

The electrical schematic of the power sub-circuit of the experimental circuit is shown in Fig. 2. It 
represents a full-bridge DC/DC converter supplying a permanent-magnet DC motor. The parameters 
of this motor are as follows: rated voltage Ur = 24 V, rated power Pr = 20 W, armature inductance 
Larm = 1.46 mH at f = 1 kHz, armature resistance Rarm = 1.20 Ω. 

Subscripts used in figures have been composed in a unified manner, according to the following 
scheme: 

� L as a first letter – left leg of the bridge, 

� R as a first letter – right leg of the bridge, 

� L as a second letter – low-side transistor, 

� H as a second letter – high-side transistor, 

� M as a second letter – middle point of a leg, 

� G – a transistor’s gate. 

The microprocessor-based control sub-circuit is composed of a red development board 
containing the MSP430G2231 microcontroller and a white interface circuits board. The white board 
contains an optical isolation circuit for the signal input from the microcontroller, a MOSFET-based 
inverter and two transistor gate drivers (one for the left and another for the right leg of the bridge). 
A detailed schematic of the control sub-circuit, including the interface circuits board and the 
development board resources used is presented in Fig. 3. 

By running an appropriate program, the microcontroller generates a pulse wave corresponding 
(as far as the waveform is concerned) to the vG(RL) waveform, i.e., the drive voltage for the right low-
side transistor’s gate. On the interface circuits board, it passes through a diode optocoupler U1 
thanks to which the microcontroller is separated from the power circuit and the motor which 
generate considerable disturbance. The task of the NMOS inverter built upon the Q1 transistor is 
first of all to increase the signal amplitude, as the voltage of 5 V, which is the maximum supply value 
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for the optocoupler, is insufficient for power transistor gate drivers. But the negation function itself 
is also needed because the optocoupler used is an inverting circuit (applying a high state to the input 
diode turns on the output transistor which results in a low state at the output). This way, we obtain 
a waveform of an amplitude equal to the supply voltage CVCC and a shape consistent with the 
waveform generated by the microcontroller. 

Fig. 2. Power sub-circuit electrical schematic of the experimental circuit 

This waveform is then input to the gate driver U2 which generates the true vG(RL) voltage, having 
the same form and amplitude but providing a current capability necessary for charging a power 
transistor’s gate. The same driver also generates the vG(RH) waveform driving the gate of the right 
high-side transistor. The other inverter, built upon the Q2 transistor, and the other double gate 
driver U3 provide the vG(LL) and vG(LH) drive voltages for the transistors in the left leg of the bridge. 
The right low-side transistor’s gate voltage vG(RL) will be considered the basic signal, with respect to 
which all the other ones are analysed. Its duty cycle will be denoted DGRL which therefore also 
represents approximately (neglecting any asymmetrical delays in the propagation path) the duty 
cycle of the signal generated by the microcontroller. 

The pulse wave is generated by the microcontroller’s hardware, in a dedicated module of the 
integrated circuit, without constantly and explicitly involving the program. However, this module is 
software-configurable. In the case of the present exercise, this means the possibility to define the 
duty cycle through the TACCR1 register. In order to simplify exercise realisation, this module has 
been configured so that the contents of this register were numerically equal to the duty cycle DGRL 
expressed as a percentage, i.e. a number from the range of 0 to 100 (not 0 to 1). The S3 button located 
on the interface circuits board and connected to pin P1.3 of the microcontroller will be used to 
activate the generator. 

The complete experimental circuit, composed of the power sub-circuit with the motor and the 
control sub-circuit including two boards, is placed on a main board according to Fig. 4. 

Voltages at selected circuit points, as marked in Fig. 2, have been led out to white connector 
blocks. Emitter nodes, labelled vE and only used to connect the power circuit to the control circuit, 
are an exception; their voltages are however identical to the vgnd, vLM and vRM voltages which are  
accessible through the connector blocks. The arrangement of these connector blocks is presented in 
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Fig. 4. The same drawing also presents the arrangement of wires led out to enable measuring 
currents marked in Fig. 2. 

Results are recorded using the TDS1002B (Fig. 4a) or the TDS224 (Fig. 4b) oscilloscope. 
Oscilloscope configuration should be carried out at the time indicated in this manual and according 
to guidelines given. For current measurements, an autonomous current probe is used (without a 
separate amplifier). The DC component of the motor current is measured with a multimeter. 

Rotational speed measurement 

On the white board, the rotational speed measurement circuit has been placed, too. It is 
composed of an emitting diode D2, supplied together with the rest of the interface circuits, and a 
receiver phototransistor Q3, supplied from the microcontroller board and connected with the 
microcontroller (via the interface circuits board where the R7 resistor has been mounted), both 
operating in the infrared range. These components have been mounted close to the motor axis, 
opposite to one another. 
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Fig. 3. Electrical schematic of the control sub-circuit of the experimental circuit 
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When the motor rotates, a screen installed on its shaft in the form of a two-blade “propeller” 
periodically interrupts the infrared light beam illuminating the phototransistor, which results in its 
being turned off. At these moments, a high voltage level (the microcontroller supply voltage VCC) 
appears at the collector of this transistor, while a low level (zero voltage) is present there for the 
remaining time, when the transistor is driven by the light beam. 

The signal obtained in the above way, which takes the form of a pulse train, is input to the pin 
P1.1 of the microcontroller. This pin is configured as an input issuing interrupt requests upon 
detection of a rising edge. A variable named pwm_periods_counter is used in the microcontroller’s 
program, in which subsequent periods of the transistor bridge control signal are counted. In the 
interrupt service routine for the P1.1 input, the current value of this variable is copied to the 
periods_per_halfrev variable whereas the value of pwm_periods_counter itself is cleared and counting 
starts back from zero. 

(a) 
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Fig. 4. Measurement set-up diagram showing component layout on the experimental circuit board (including 
connectors and wires providing access to voltages and currents): (a) with the TDS1002B oscilloscope; (b) with 
the TDS224 oscilloscope 
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(b) 
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Fig. 4. (cont.) 

Thus, the periods_per_halfrev variable contains the number of control waveform periods that 
have passed between subsequent interrupts, or between subsequent pulses coming from the 
phototransistor. It is therefore the number of periods that corresponds to one half-revolution of the 
motor, as the two-blade screen masks the phototransistor every half-revolution. The value of this 
variable, Nhrev, can be read on the computer on an ongoing basis. 

If, in addition, the frequency of the bridge control signal fs is known, then the rotational speed n 
of the motor can be calculated in a simple way. In each one-second interval, there are fs periods of 
the control waveform. On the other hand, the duration of the motor’s one half-revolution is Nhref 
times longer than one such period, so one full revolution is 2Nhrev times longer. The number of 
revolutions in each one-second interval is therefore 2Nhrev times lower than the number of control 
waveform periods (in each one-second interval); but this latter number of periods is nothing else but 
the fs frequency. This can be expressed mathematically with the formula: 
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Circuit configuration 

Fig. 4 also shows a block diagram of the complete measurement set-up taking into account the 
two possible laboratory stands. It should be assembled in the way described below, following the 
order of actions given. If an oscilloscope model designation is given at a given point, this means that 
this point only applies to this given oscilloscope model while it should not be performed when 
another oscilloscope model is used. 

In order not to waste time, following steps should be carried out in parallel with step 1. 

1. Turn on the PC. Turn on the oscilloscope and configure the connection to the PC strictly 
according to the procedure described in the manual available at the laboratory stand. 

2. On a power supply with two adjustable sections, while keeping it turned off: 

� select the Independent mode of operation (two buttons in the middle of the front panel 
whose setting explanation can be found on the panel above them), 

� connect the “−” terminals of both adjustable sections one with another, 

� connect the “−” terminal of one of the adjustable sections to the supply network 
protective earth terminal of the power supply (GND); 

� turn all the knobs to zero (extreme counterclockwise position). 

3. Bring power to the interface circuits board: using wires with insulated alligator clips, connect 
the adjustable section of the power supply which has its “−“ terminal grounded to the two wires 
leading out of the board, of which the red one is the positive end and the blue one is the negative 
end. 

4. Bring the converter input voltage Ui (see Fig. 4) from the other adjustable section of the power 
supply. 

5. Insert a multimeter operating as an ammeter in series with the motor, in the following way: 

(a) using a screwdriver, disconnect the motor from the vRM socket (not any other) on the circuit 
board; 

(b) connect the vRM socket to the COM input (not any other) of the multimeter; 

Only in the above conditions will the current sign displayed by the multimeter conform to its 
direction as marked in Fig. 2. 

(c) connect the released wire from the motor to the current input of the multimeter of an 
appropriate maximum load, using an alligator clip attached to a banana plug; 

(d) set the multimeter into the DC current mode of 1 A at least; 

(e) leave the multimeter switched off. 

6. Connect (or verify existing connections) the interface circuits board to the microcontroller board 
(J1 and J2 pin headers) through pin connectors, in the following order starting from the one 
located closest to the power supply wires (those used in step 3, see Fig. 4): 

� blue wire, to pin P1.2, 

� black wire, to pin GND, 

� green wire, to pin P1.3, 

� white wire, to pin P1.1, 

� red wire, to pin VCC. 

7. Make sure that: 

(a) on the microcontroller board, using jumpers, connected are (see Fig. 4): 

� the LED2 indicator to pin 1.6 (pin 2 of the J5 pin header), 
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� the TEST, RST, RXD, TXD signals and the VCC supply voltage from the programming 
and debugging interface block to the microcontroller block (all the pins of the J3 pin 
header); 

(b) no accidental shorts of neighbouring component leads are present on the interface circuits 
board. 

Before proceeding with the following step, connections must be checked by the teacher. 
This step must be first read in its entirety and only then one should proceed with its 
execution. 

Under normal operating conditions, during and after execution of the following step, the 
current drawn indicated on the power supply ammeter should not exceed 0.15 A. If, while 
setting voltage or later, anything else is observed, immediately turn off the power supply 
and ask the teacher to check the circuit once again. 

8. Turn on the power supply. Slightly increase the current limit (Current knob) of the section 
which supplies the control circuit (the interface circuits board) until red current limiting 
indicator (C.C.) goes out. In this section, set the voltage (Voltage knob) to 10 V. If the current 
limiting mode is activated in the course of setting (the red indicator lights up), first decrease the 
voltage (turn the Voltage knob counterclockwise) so as the red indicator extinguishes, next 
increase the current limit and only after that try to set  the desired voltage again. 

9. Connect the microcontroller board to the computer through a USB A/Mini-B cable long enough 
(do not use any extension cable as this would degrade transmission quality to an extent 
disabling communication). In the case a hardware installation window appears, do not close it, 
instead ask the teacher to introduce the password in order to complete the installation. The 
green PWR LED should light up on the microcontroller board. 

Microcontroller configuration 

10. From the Start Menu, run the Texas Instruments Code Composer Studio environment, while: 

(a) during its start: 

� in the Workspace Launcher dialog, enter H:\workspace as the path and check Use this as 
the default and do not ask again, 

� accept any possible further suggestions; 

(b) after it starts: 

� in the CCS App Center – Pending Installation dialog, click No; 

� in the Getting started window, select Yes for Would you like to use CCS in ‘Simple’ mode. 

11. Create a new project: choose File ‣ New ‣ CCS Project and in the dialog displayed: 

� choose Target: MSP430G2231; 

� give the project a name, e.g., motor, check Use default location; 

� on the Project templates and examples list choose Empty Grace (MSP430) Project; 

� click Finish; after the dialog closes, wait for the project configuration process to 
terminate, which will be indicated by displaying a Grace (MSP430) – Welcome page. 

12. Replace project sources with the bridge converter controller program: 

(a) close the file main.cfg and do not open any other project files for now; 

(b) delete the files main.c and main.cfg as presently found in the project folder located in 
H:\workspace; 

(c) copy the files main(en).c and main.cfg found in the laboratory folder to the project folder; 

(d) rename the file main(en).c found in the project folder to main.c; 

(e) in the programming environment, from the Project Explorer pane found in the left side panel, 
open the file main.c.  
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13. Compile the program, generate the machine code and run it in debug mode by clicking the 
Debug main.c icon (a green one) in the toolbar. In the ULP Advisor dialog, check Do not show this 
message again and click Proceed. 

Oscilloscope configuration 

14. Using a voltage probe, connect the vG(RL) voltage to the oscilloscope, using: 

� [TDS1002B] synchronisation input (EXT TRIG), 

� [TDS224] channel 3 input (CH3). 

In this exercise, ground terminals of all probes should be connected to the vgnd node, which is 
connected both to the ground of the control sub-circuit and to the negative terminal of the 
power sub-circuit supply. 

[TDS1002B] Using the switch found on the probe holder body, set the attenuation to 10x. 

Any other ground connection for any probe will cause a short circuit through the 
oscilloscope, which can damage its input circuitry! 

15. Using a separate voltage probe, connect the same voltage vG(RL) to the oscilloscope’s channel 1 
input. Using a voltage probe, connect the voltage vG(LL) to the oscilloscope’s channel 2 input. 

[TDS1002B] Using switches found on probe holder bodies, set the attenuation to 10x. 

16. Using the oscilloscope communication software, upload initial settings to the oscilloscope: 

[TDS1002B] 

� go to the Get & Send Settings tab; 

� press Open and read the 4b_tds1002b_napięcia.set file; 

� press Send Settings; 

� return to the Screen Capture tab. 

[TDS224] 

� from the menu, choose File ‣ Open and open the file ustawienia_4b_tds224_hz56.sht; 
choose Offline in the dialog that appears; 

� on the list displayed in the left panel, unfold the installed oscilloscope ‣ Data ‣ Settings; 

� in the settings file window, select its entire contents and drag them to the Full Setup item 
in the left side panel using the mouse; 

� wait for the introduction of settings on the oscilloscope to complete, which process is 
indicated by changes of elements on the screen (letters, numbers, curves). 

Operation test 

17. Run the program: 

(a) check if, after the executable has been built, the debugger has been launched and has 
stopped at the first line of the main() function; in case it has not: 

� if compilation errors have been shown, this indicates that steps 10—12 have been carried 
out incorrectly or incompletely; in order not to waste time on searching for the exact 
cause, these steps should be now repeated while creating a new project under a new 
name, 

� if the Debug window is missing, try to display it from the menu Window ‣ Show View ‣ 
Other…, 

� if the debugger has not stopped in the line given above, double click the “main(…)() at 
main.c” item in the Debug pane; 

An appropriate of the above actions should be also performed if later on the debugger does not 
start correctly after compilation is finished. 
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(b) launch program execution by clicking the Resume button in the toolbar. 

18. Push the S3 button on the interface circuits board, which should start the generation of the 
bridge transistors control waveform, indicated by the LED2 lighting up. 

19. Looking at the oscilloscope image: 

� make sure that both 1 and 2 channel waveforms are displayed on the screen; 

When a channel waveform is displayed, this is indicated with an arrow with this channel’s 
number appearing left of the graticule as well as this channel’s symbol appearing below the 
graticule together with its current gain setting. In the case of the Math waveform that is 
created as a result of a mathematical operation, the symbol is (will be) the M letter. 

Pressing the Menu button of a given channel alternatively displays and hides the 
corresponding waveform. 

� state whether the waveforms have a rectangular form and are visible within a time 
window corresponding to their 3 to 6 periods; adjust the time base (Sec/Dev knob) if 
needed; 

� ensure that the gain is set to 10 V/div in both channels; this setting is appropriate for 
every voltage measurement and it should not be modified for the entire course of the 
exercise; 

� state whether the amplitude of the waveforms is clearly visible and whether they can be 
distinguished one from another; if needed, adjust the zero levels of the waveforms 
displayed (Vertical Position knobs). 

Aligning zero levels of every waveform investigated in this exercise with the “large” 
graticule will make result analysis easier (the precise setting is displayed below the graticule 
during adjustment). 

20. Verify the power circuit operation: 

(a) stop control waveform generation by pushing the S3 button again (successfully stopping the 
generation must be indicated by the LED2 diode going out); 

Under normal operating conditions, during execution of the following step, the current 
indicated by the ammeter of the power supply section that supplies the power circuit 
should not exceed 0.1 A and it should return to zero after carrying out that step. If 
anything else is observed, immediately turn off the power supply and ask the teacher to 
check the circuit once again. 

(b) on the power supply, using the Current knob, for the section supplying the power circuit, set 
current limit to its maximum (extreme clockwise position); 

(c) with the Voltage knob of the section mentioned above, set the voltage to 24 V; 

After the motor is started, the power supply voltmeters can indicate voltages higher 
than set above. Such indications are false and result from disturbances generated by the 
bridge with the motor. Therefore, do not take any action related to this fact; in 
particular, do not change the settings of the Voltage knobs which should remained 
unchanged until the end of the exercise. 

(d) activate control waveform generation using the S3 button on the microcontroller board. The 
motor should start rotating, driving a current of about 0.3 A from the power supply. If 
anything else is observed, turn off the power supply and ask the teacher to check the setup 
once again. 

Later on, the current drawn from the power supply may be higher than the one given above. 
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3.2. Transistor drive 

1. Stop the motor by pushing the S3 button. 

2. From the web page, obtain the initial duty cycle value DGRL(1). In the main.c code window, 
replace the current duty cycle DGRL value being written to the TACCR1 register (see the 
description in Section 3.1) with DGRL(1). 

Stopping the debugger is not necessary to make changes in the code. 

3. Generate the machine code and run the program, then activate the controller (see steps 3.1/13 
and 17–18). 

Saving the source code before generating the machine code is not necessary; this will be suggested 
automatically. If the debugger is active, the environment is in its Debug mode, then launching the 
Build All (Ctrl+B) or Build ‘Debug’ for project … (a toolbar icon) will automatically save the source 
code and restart debugging after the machine code is generated. The Resume command can be equally 
(apart from using the icon) launched by pressing F8. 

4. Based on the waveforms displayed by the oscilloscope, determine if the vGRL signal indeed 
exhibits the duty cycle determined above (with an accuracy that can be achieved based on the 
present oscilloscope image, without modifying any of its settings). Go back  to step 1 otherwise. 

5. Using the oscilloscope communication application, download and save the oscilloscope image of 
the vG(RL) and vG(LL) voltages: 

[TDS1002B] in the application, press Get Screen and then Save As (confirm with the mouse as 
using the Enter key will cause the dialog box to reopen). 

[TDS224] create a new LibreOffice Writer document, then from the left side panel of the 
application, drag the Display ‣ Screen Copy item to the file created; right-click on the inserted 
picture and choose Anchor ‣ As character from the context menu. 

As already stated, in order to facilitate further data analysis, the gain of 10 V/div in channels 
used for voltage measurements should be kept unchanged throughout in the entire course 
of the exercise. 

6. Reapply the channel 2 probe so that it measures the vG(RH) voltage (still displaying the vG(RL) 
voltage). If needed, adjust waveforms position (Vertical Position) so that they can be 
distinguished one from another, but without changing channel gains. Download and save the 
oscilloscope image. 

7. Repeat step 6 with respect to the vG(LH) potential. 
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3.3. Characteristics of the full-bridge converter with the motor 

Motor voltage waveforms 

1. Record the waveforms of potentials at the two terminals of the motor: 

(a) reapply the appropriate probe so that to measure: 

� the vLM potential in channel 1, 

� the vRM potential in channel 2; 

(b) if needed, adjust zero levels so that the waveforms can be distinguished one from another; 

(c) download and save the oscilloscope image. 

2. Record the waveform of the voltage across the motor as the difference of voltages at its 
terminals: 

(a) [TDS224] set zero levels of both channels 1 and 2 in the middle of the screen; 

(b) activate mathematical functions by pressing Math Menu; an additional Math waveform 
should show up on the screen, whose zero level is marked by an arrow with the M letter 
appearing left of the graticule; 

(c) ensure that in the menu that displays, the subtraction operation CH1−CH2 is selected, which 
gives the armature voltage uarm = vLM – vRM (see Fig. 2); 

(d)  [TDS1002B] in the menu displayed, for the Math waveform: 

� set the vertical scale to 10 V/div by selecting Vertical Scale and using the large knob in 
the top left corner of the oscilloscope panel, 

� move the zero level to the middle of the screen by selecting Position and using the large 
knob as above; 

(e) hide channel 1 and 2 waveforms (only the difference waveform M displayed), 

(f) download and save the oscilloscope image. 

Setting up characteristics measurement 

3. On the oscilloscope: 

(a) in order to obtain stable results, activate the averaging mode by pressing the Acquire button 
and choosing Average from the screen menu; 

(b) [TDS224] show channel 1 and 2 waveforms; 

(c) activate the measurement functions with the Measure button; in the consecutive fields (from 
top to bottom), the following measurements should be selected: 

[TDS1002B] 

� in the first field, the mean value (Mean) of the armature voltage uarm(av) (i.e. of the 
subtraction result Math), 

� in the third field, the armature voltage (Math) frequency (Freq). 

[TDS224] 

� in the first and the second fields, the mean values (Mean) of bridge leg middle points 
vLM(av) and vRM(av) (i.e. of channel 1 and 2 waveforms Ch1 and Ch2), 

� in the third field, the left leg middle point voltage (Ch1) frequency (Freq). 

4. Reconfigure the programming environment so that to enable rotational speed measurement: 

(a) in order to speed up measurements, in the program code main.c, modify the line above the 
TACCR1 value assignment so that the motor starts automatically after running the program, 
by changing the argument of the EnablePWM() function from 0 to 1; 
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(b) in the program code main.c, find and highlight (with mouse or keyboard) the name of the 
variable periods_per_halfrev, right-click and select Add Watch Expression to add it to the 
watch list. 

(c) generate the machine code and run the program again. 

5. Switch on the multimeter. 

If the battery discharge indicator (a battery symbol) shows up on the meter’s display, do not 
continue measurements but ask the teacher to replace the battery. Otherwise meter 
indications may become erroneous. 

6. Set the initial value of the duty cycle: 

(a) in the program code, change the duty cycle value (see step 3.2/2) to DGRL(2) which should be 
obtained from the web page; 

(b) stop the motor using the S3 button; 

(c) re-generate the machine code and run the program again; 

(d) watching the ammeter (multimeter) indication, wait until this readout stops varying 
considerably with time (this concerns a noticeable change in one direction, not omnipresent 
random variations in random direction). This may require a few minutes of operation. 

The characteristics of the motor under investigation (such as coefficient of friction or armature 
resistance) change considerably with temperature. It is therefore important to carry out the 
measurements on a warm motor, because then characteristics will not vary in time. 

In order not to waste time, while the motor is heating up, execute step 7, read steps 8—10 and 
determine the resulting (from both step 8 and steps 9—10) set of measurement points (e.g. DGRL 
values) for which control characteristics will be measured. In the case of a delay in exercise 
realisation, skip further waiting for the motor to heat up after the abovementioned set of 
measurement points is determined. 

Control characteristics measurement 

7. Read out and write down the exact values of: 

(a) converter input voltage Ui, as indicated by the appropriate power supply section voltmeter; 

(b) bridge switching frequency fs, as indicated on the oscilloscope [see step 3(c)]. 

Before starting the execution of the following step, it should be first read in its entirety, e.g 
up to the location where the next step begins. 

8. For 5—8 measurement points defined by the duty cycle values DGRL changed in the range 
between its current value and 50%, perform measurements, reading out and writing down: 

(a) from the multimeter, the DC component of the armature current Iarm(0) (including its sign); 

(b) from the oscilloscope, the average value (Mean indication including its sign) of: 

� [TDS1002B] the armature voltage uatm(av); 

� [TDS224] the left and right leg middle point voltages vLM(av) and vRM(av); 

(c) from the programming environment: 

� the duty cycle DGRL of the vG(RL) waveform (TACCR1 register content which is a 
percentage value), 

� the number of control waveform periods per motor half-revolution Nhrev, which is the 
value of the periods_per_halfrev variable, whose present value must be read before from 
the microcontroller by pausing the debugger with the yellow Suspend button in the 
toolbar; 

(d) rotation direction (clockwise or counterclockwise as seen from the front of the motor body, 
i.e. from the shaft side), by visual observation for these duty cycles for which the motor 
rotates sufficiently slow. 
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The set of measurement points must contain among others the following DGRL values: 

� DGRL(2) (DGRL(3) when repeating measurements according to step 10), 

� 50%, 

� DGRL(1) if it is contained between the two above. 

Changes to the duty cycle DGRL should be made in analogy to steps 6(a)—(c), i.e. for its each 
consecutive value, it is necessary to: 

� stop the motor beforehand using the S3 button, 

� change the duty cycle value in the program, 

� generate the machine code and run the program again. 

9. Repeat step 6 but this time applying the initial value of DGRL(3) instead of DGRL(2). 

10. Repeat step 8 starting from DGRL(3), but skipping the measurement for DGRL = 50%. 
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3.4. Power circuit voltage and current waveforms 

Motor voltage 

1. For 2 (*3) different values of the DGRL duty cycle: 

(a) DGRL(1); 

(b) such that the motor is rotating with a rotational speed [corresponding to the value of the 
variable periods_per_halfrev which is to be read out as in step 3.3/8(c)] similar (do not put 
effort in obtaining it equal) as for DGRL(1) but in the opposite direction [an appropriate value 
can be predicted base on Eqs. (2.17) and (2.4)]; 

(c) * such that the motor is rotating in the same direction as for DGRL(1) but with a significantly 
different rotational speed; 

carry out the following: 

[TDS1002B] 

� download and save the oscilloscope image of the armature voltage uarm; 

� if for a given DGRL value there are no results from Section 3.3, read out and write down: 

� the number of control waveform periods per motor half-revolution Nhrev (the value 
of the variable periods_per_halfrev from the programming environment), 

� the average value of the armature voltage uarm(av) (the Mean indication on the 
oscilloscope). 

[TDS224] 

� if channel 1 and 2 waveforms are displayed on the oscilloscope, hide them; 

� download and save the oscilloscope image of the armature voltage uarm; 

� if for a given DGRL value there are no results from Section 3.3: 

� read out and write down the number of control waveform periods per motor half-
revolution Nhrev (the value of the variable periods_per_halfrev from the programming 
environment), 

� show channel 1 and 2 waveforms on the oscilloscope, 

� press the Measure button, 

� read out and write down the average values of the bridge middle point voltages 
vLM(av) and vRM(av) (the Mean indications on the oscilloscope). 

Motor current 

2. [TDS1002B] Disconnect the channel 1 and 2 voltage probes from the circuit and from the 
oscilloscope (leave the probe that is connected to the trigger input). 

3. Re-configure the oscilloscope: 

[TDS1002B] 

� proceeding as in step 3.1/16, upload oscilloscope settings from the file 
4b_tds1002b_prąd_hz56.set. 

[TDS224] 

� turn off waveform averaging by pushing Acquire and choosing Sample from the screen 
menu; 

� hide all the waveforms presently displayed (the subtraction result Math and, possibly, 
channel 1 and 2 waveforms); 

� show the channel 4 waveform. 
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4. Connect the current probe to the channel 1 ([TDS224] channel 4) of the oscilloscope. Switch it on 
and calibrate according to the procedure described in the operating manual available at the 
laboratory stand (skip oscilloscope configuration). 

5. Clamp the current probe around the wire leading the armature current iarm so that the arrow on 
the probe body, which indicates the current direction taken as positive, is in conformance with 
the arrow in Fig. 4. 

6. For the same 2 (*3) duty cycle values as in step 1: 

� download and save the oscilloscope image of the armature current iarm; 

� if for a given DGRL value there are no results from Section 3.3, write down the DC 
component of the armature current Iarm(0) (the indication of the multimeter). 

Transistor switch currents 

7. * By clamping the current probe around appropriate wires, without changing any settings, for 
the duty cycle of DGRL(1), record the waveforms of all the four switch currents: iRL, iRH, iLL, iLH, 
paying attention to their directions (see Fig. 4). 

Measurement termination 

8. Stop the motor using  the S3 button. 

9. Bring down to zero the power circuit supply voltage and next, the control circuit supply voltage. 

10. Close the programming environment and unplug the USB cable from the socket on the 
microcontroller board. 

11. Disconnect the current probe from the circuit and turn it off with the button on its body. 

12. Turn off the multimeter and disconnect it from the circuit. Connect the released motor wire 
back to the vRM socket and tighten the screw. 

13. Remove all remaining connections. 
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D 

Results 

4. Result Elaboration and Analysis 

4.1. Full-bridge converter 

For consistency with the Polish version, throughout this chapter, armature will be denoted with the 
subscript “arm,” whereas in the references and in Sub-chapter 2.2, it is denoted “a” and the armature 
voltage is denoted vt. Average values and DC components will be denoted with subscripts “av” and 
“0,” respectively, whereas they are marked with capital letters in the references and in Sub-chapter 
2.2. 

Control voltages 

1. On a single page, collect the oscilloscope images of voltages recorded at the duty cycle of DGRL = 
DGRL,ini: 

� vG(RL) and vG(LL) (step 3.2/5); 

� vG(RL) and vG(RH) (step 3.2/6); 

� vG(RL) and vG(LH)  (step 3.2/7). 

2. Based on the oscilloscope images of gate voltages for the four transistors of the bridge, 
determine what switch control scheme was used in the investigated full bridge circuit (see Ref. 
A, Sections 7‑7, 7‑7‑1 and 7‑7‑2). 

3. * Based on the oscilloscope images from point 1, analyse the waveforms in terms of voltage 
levels: 

(a) using the graticule, read out the approximate value of the gate voltage vG of each of the four 
transistors which was applied to turn on a particular transistor; 

(b) which of the two voltages can be directly linked to the supply voltage of the gate drivers (see 
Fig. 3 and step 3.1/8)? 

(c) justify the values of the other two voltages considering: 

� what exactly is the controlling quantity for an IGBT (leaving aside the issue of charge, 
see report on Ex. 4A or e.g. Manual 4A, Ref. A, Fig. 8.43), 
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� voltage waveforms of bridge middle points recorded in step 3.3/1: vLM = vE(LH) and vRM = 
vE(RH); 

(d) considering your conclusions from point (c), is the role of the gate drivers U2 and U 3 only to 
repeat pulse waves fed to their inputs (see Section 3.1, Circuit description), or do they also 
have any other task to fulfil? 

Power circuit 

4. Analyse the output voltage waveform of the full-bridge DC/DC converter at the duty cycle of 
DGRL = DGRL,ini: 

(a) gather the oscilloscope images: 

� of the middle point voltages vLM and vRM, registered in step 3.3/1, 

� of the output (motor armature) voltage uarm, registered in step 3.3/2; 

(b) from the oscilloscope images, read out the values of the high and the low levels of each of 
the above waveforms and on this basis, calculate the amplitude (peak-to-peak value) of each 
of them, vLM(pp), vRM(pp) and uarm(pp); 

(c) link the output voltage value uarm in each of the two subintervals of circuit operation to the 
voltages vLM and vRM. 

5. * Analyse current waveforms of the bridge switches: 

(a) on a single page, gather the current waveforms recorded at DGRL = DGRL,ini: 

� the output current iarm for the above duty ratio, recorded in step 3.4/6, 

� currents of the four switches of the bridge iRL, iRH, i LL and iLH, recorded in step 3.4/7; 

(b) justify the waveforms of the iRL, iRH, iLL and iLH currents referring to the iarm waveform as 
well as to the control voltage waveforms analysed in point 2; 

(c) considering current directions in Fig. 2, justify the direction (sign) of each of the currents as 
observed in the corresponding oscilloscope image; 

(d) which semiconductor devices are involved in the conduction of the output current iarm in the 
case under investigation (see Ref. A, Sections 7‑7 and 7‑7‑1)? in the oscilloscope image of 
current iarm, mark the different time intervals and label them with symbols of conducting 
devices according to Fig. 2. 

6. * Verify the matching between the converter and the motor: 

(a) based on the switching frequency fs written down in step 3.3/7(b) and the parameters of the 
motor used as given in Section 3.1, determine the ratio of τo/Ts, where τo is the armature 
time constant (considering the armature as an RL load) and Ts is the converter switching 
period; 

(b) state whether the converter meets the matching condition with respect to the motor, i.e. its 
switching period is much less than the time in which an RL load current would reach a 
steady state: 

 os 5τ<<T  (4.1) 

(c) how, if at all, is the conclusion from point (b) confirmed by the waveforms of the output 
current iarm? 

Conversion characteristic 

7. In a table, collect measurement results obtained for different values of the duty cycle (steps 3.3/8 
and 10): DGRL, Iarm(0), uarm(av) or vLM(av) and vRM(av), Nhrev and the direction of rotation (using 
symbols �/� or acronyms CW/CCW to denote “clockwise” or “counterclockwise,” 
respectively). For the direction of rotation, observations for low speeds should be extended to 
the other measurement points coming from step 3.3/8 or from step 3.3/10, respectively. 
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8. [TDS224] Based on measured average values of the voltages vLM(av) and vRM(av), calculate for each 
measurement point the average value of the armature voltage uarm(av) in accordance with Fig. 2, 
i.e. including accordance with this voltage direction in this figure. 

9. Based on measurement results, using the value of the input voltage Ui written down in step 3.3/7 
(include its value in the report), for each value of the duty cycle DGRL, calculate and add to the 
table: 

(a) the relative average output voltage uo(av)r, from its definition (2.5); 

(b) the relative average output voltage for an ideal converter uo(av)r,id, from Eq. (2.6). 

10. Analyse the conversion characteristic of the converter: 

(a) plot in one graph the voltage conversion characteristics: the one determined experimentally 
for the investigated converter uo(av)r = f(DGRL) and the theoretical one for an ideal converter 
uo(av)r,id = f(DGRL); 

(b) what is the nature of the experimental and the theoretical relationships? 

(c) how, if at all, do these two characteristics differ quantitatively (in terms of the values 
exhibited)? is this in line with expectations (see Section 2.2.c)? 
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4.2. Armature control of a DC motor 

Elaboration of measurement results 

1. Based on measurement results, for each value of the duty cycle DGRL, calculate and add to the 
table: 

(a) motor rotational speed n, based on Eq. (3.1), using the switching frequency value written 
down in step 3.3/7, except that if the controller program indicated Nhrev = 0, then this means 
n = 0; 

(b) motor angular velocity ω, based on Eq. (2.1), taking into account that this is a vector 
quantity, so its value has a sign corresponding to the direction of rotation; assume that the z 
axis points towards the observer and therefore, assign the “+” sign to the counterclockwise 
direction; 

(c) armature average electromotive force earm(av), based on Eq. (13‑12) and using the motor data 
given in Section 3.1; 

(d) converter average output power Po, assuming a triangular current waveform and therefore 
using Eq. (2.7); 

(e) * (average) internal mechanical power of the motor P′mec(av), using Eqs. (13‑4) and (13‑6), 
assuming that ω = const and earm = const = earm(av), resulting in 

 arm(0)arm(av)avarmarm(av)avarmarmelmec(av) )()( IeieiePP ⋅=⋅===′  (4.2) 

(f) * (DC component of) electromagnetic torque of the motor Tem(0), based on Eq. (13‑5) (this is 
of course impossible for ω = 0, so such points are to be skipped); 

(g) * total equivalent coefficient of friction Beq, based on Eq. (2.12) re-written for idling, as the 
engine was not loaded with any external torque, i.e. TWL = 0. 

Rotational speed control 

2. Analyse the regulation characteristic of the motor under investigation: 

(a) plot the regulation characteristic of idle speed with armature control, i.e. n = f(uarm(av)) at Φf 
= const (since a permanent magnet motor was used) and TWL = const = 0 (since the engine 
was not loaded), while placing characteristics for both directions of rotation in one graph, 
but as two separate curves; 

(b) what is the nature of the relationship plotted? does it agree with theoretical predictions (see 
Section 2.2.e)? 

3. Analyse the armature voltage and current waveforms for different control conditions: 

(a) on a single page, gather oscilloscope images of armature voltage uarm and current iarm 
recorded in steps 3.4/1 and 6 (place each current image next to the corresponding voltage 
one): 

� for the initial duty cycle DGRL,ini, 

� for a similar rotational speed in the opposite direction, 

� * for a different rotational speed in the same direction. 

(b) link the average values of the output voltage uarm(av) to the respective waveforms (see Ref. A, 
Sections 7‑7 and 7‑7‑1); 

(c) in what way had the armature voltage waveform uarm to be changed in order to obtain motor 
rotation at the same speed in the opposite direction? how did this change affect the DC 
component of the armature current Iarm(0) (link numerical data to Iarm current waveforms) 
and is this consistent with theoretical predictions (see Section 2.2.d)? 
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(d) based on the steady state torque equation (2.12) and a suitable relationship linking torque 
with current (see Ref. B, Section 13‑3), justify why it was the very change in the current 
observed in point (c) that was required to reverse the direction of rotation (and thus the sign 
of the angular velocity); 

(e) * re-apply the reasoning of points (c)—(d) to the case where the rotational speed of the motor 
was changed without changing the direction of rotation. 

Motor constants 

4. Determine the relation of electromotive force to angular velocity: 

(a) plot armature electromotive force earm as a function of motor angular velocity ω (a single 
curve for both directions of rotation); 

(b) determine the nature of this relationship and state whether it agrees with theoretical 
predictions (see Ref. B, Section 13‑3); 

(c) on the graph, using an appropriate spreadsheet function, display the linear regression line 
for the measured relationship together with its equation (LibreOffice: double-click the graph 
to enter the editing mode, then select Insert ‣ Trend Lines from the menu, choose Linear as 
the type and check Show equation); change the number format of the displayed regression 
line coefficients to get an accuracy of three significant digits (LibreOffice: select the equation 
by clicking on it, press the Format Selection (Calc) button in the toolbar and go to the 
Numbers tab); 

(d) assuming that relationship (13‑11) holds, from the regression line equation shown, read out 
the value of the voltage constant kE of the motor under investigation. 

5. * Determine the relation of torque to armature current: 

(a) plot the DC component of the electromagnetic torque Tem(0) as a function of the DC 
component of the armature current Iarm(0) (one curve for both directions of rotation); 

(b) determine the nature of relationships and state whether it agrees with theoretical 
predictions (see Ref. B, Section 13‑3); 

(c) on the graph, using an appropriate spreadsheet function, display the linear regression line 
for the measured relationship together with its equation as in point 4(c); it may be necessary 
to remove points from the graph that correspond to very low speeds if they are clearly 
located far from a straight line; 

(d) assuming that relationship (13‑10) holds, from the regression line equation shown, read out 
the value of the torque constant kT; 

(e) is it possible (bearing measurement uncertainty in mind) to state that experimental results 
confirm the relationship (13‑7)? 

Power conversion 

6. * Analyse the coefficient of friction: 

(a) plot the equivalent coefficient of friction Beq as a function of angular velocity ω (two 
separate curves in one drawing for the two directions of rotation); 

(b) describe the observed relationship; 

(c) from the graph, read out the approximate value of Beq(min) which the coefficient of friction 
tends to. 

7. * Obtain theoretical control characteristics of average power: 

The calculations should be performed for each measurement point and, if necessary, also for 
additional duty cycle values so that in step 8(a), a smooth curve is obtained in the full duty cycle 
range from 0 to 1. 
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(a) calculate the theoretical average output power Po(theo,RL) for an ideal (lossless) converter with 
an RL load, based on Eq. (2.9) and considering that motor armature is the receiver, hence Ro 
= Rarm; 

(b) calculate the theoretical average output power P(theo,RLE) for an ideal converter with a real 
RLE load representing an idling DC motor, based on Eq. (2.22) and using the values of kE, kT 
and Beq(min) determined so far and the motor data given in Section 3.1. 

Collect your results in a new table or add them to the one created previously. 

8. Analyse the idling state control characteristic of average power: 

(a) plot (* in a single graph, adjusting its scale to the range of values of Po and Po(theo,RLE) and not 
that of Po(theo,RL)) the control characteristics of average power: 

� the one determined experimentally Po = f(DGRL), 

� * the theoretical one for an RL load Po(theo,RL) = f(DGRL), 

� * the theoretical one for an RLE load Po(theo,RLE) = f(DGRL); 

(b) describe the nature of the relationship obtained experimentally; 

(c) state whether this character is consistent with the one predicted with the analysis carried 
out in Section 2.2.e; 

(d) * compare the characteristic determined experimentally to the theoretical ones: 

� does the idling engine actually draw a power lower than could be delivered to an RL 
receiver with the same resistance (see Section 2.2.e)? 

� considering Eq. (2.22), which has been applied, and motor parameter values substituted 
thereto [see point 7(b)], what may be the main reason for discrepancies between the 
experimental characteristic and the theoretical one for an RLE receiver (see Section 
2.2.e)? 
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E 

Information 

5. Expected Report Contents 

Bridge converter operation 

1. Oscilloscope images of gate potentials, clearly labelled, as well as their analysis in 
respect of the switch control scheme applied, according to steps 4.1/1—3 
(i.e., 3 oscilloscope images of paired vG potentials) 

2. Oscilloscope images of quantities related to the output diagonal of the bridge, levels 
read out from them and links established between them, according to step 4.1/4 
(i.e., vLM, vRM and uarm waveforms) 

3. * Oscilloscope images of armature current and switch currents at the same duty 
cycle as well as their analysis in respect of waveform shape, direction and flow loop, 
according to step 4.1/5 
(i.e., iarm, iRL, iRH, iLL and iLH waveforms recorded for DGRL = DGRL,ini) 

4. * Analysis of bridge switching frequency selection in respect of coupling with the 
motor used, according to step 4.1/6 

5. Table containing measurement and calculation results, citing the formulae used, as 
well as the input voltage value measured, according to steps 4.1/7—8 

6. Voltage control characteristic, the experimental one and the theoretical one for the 
ideal converter, with comparative analysis, according to step 4.1/9 
[i.e., uo(av)r = f(DGRL) and uo(av)r,id = f(D) curves in one plot] 

Armature control of a DC motor 

7. Result additions to the table, citing the formulae used, according to step 4.2/1 

8. Idle state armature control characteristic of rotational speed and its analysis, 
according to step 4.2/2 
[i.e., n = f(uarm(av)) plot] 

9. Oscilloscope images of armature voltage and current for different control conditions 
and an analysis of differences between these cases, according to step 4.2/3 
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[i.e., uarm and iarm waveforms for DGRL = DGRL,ini and the same rotational speed in the 
opposite direction (* and for a different rotational speed in the same direction)] 

10. Graphical presentation and analysis of relationships between electrical and 
mechanical quantities, according to step 4.2/4 (* and 5) 
{i.e., earm = f(ω) [* and Tem(0) = f(Iarm(0))] plot(s), each with a linear regression curve 
displayed, its equation shown and the obtained value of the respective motor 
constant} 

11. * Coefficient of friction characteristic and its analysis, according to step 4.2/6 
[i.e., Beq = f(ω) plot and the value of Beq(min) read out from it] 

12. * Table (or addition to the one created earlier) containing the theoretical average 
output power for two load types, according to step 4.2/7 
(i.e., a set of values of Po(theo,RL) and Po(theo,RLE) for varying D) 

13. Idling state control characteristic of average power, an experimental one (* and 
theoretical ones for an ideal converter with an RL load and with a DC motor as an 
RLE load) with an analysis in respect of accordance with theoretical predictions, 
according to step 4.2/8 
[i.e., Po = f(DGRL) relationship plot (* three curves in a single graph)] 

6. Required Knowledge 

6.1. Prerequisites 

� Full-bridge DC/DC converter: electrical schematic, bipolar switch control scheme, 
devices conducting in different sub-periods of operation 
(see Ref. A) 

6.2. Test scope 

1. Full-bridge DC/DC converter: electrical schematic, bipolar switch control scheme. 
Devices conducting in different sub-periods of operation at different average output 
current levels. Waveforms of middle point potentials and output voltage. Average 
output voltage and its characteristic as a function of the duty cycle (formula, plot). 
(see Ref. A; Sub-chapter 2.2) 

2. Control of a permanent-magnet DC motor with a full-bridge DC/DC converter: 
average output power characteristic as a function of the duty cycle (without 
formulae), rotational speed characteristic as a function of average armature voltage 
(including the theoretical formula), direction of rotation. 
(see Sub-chapter 2.2, report) 
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